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ABSTRACT

The impetus for this project has been the continuing deterioration of, and the necessity to
repair, a large stock of concrete structures. A two-component system, portland cement concrete
(substrate) in contact with a polymer composite (repair), is produced as the result of a repair. The
reliability and durability of a repaired concrete structure and its remaining service life depends, to a
great degree, on the behavior of the repair material, which is controlled by the compatibility
between the two materials making up the repair system. The main scientific objective of this project
has been the analysis and prediction of this compatibility using the compatibility space concept,
which is defined mathematically, with the aim of understanding the nature of the two-component
repair system. The engineering objective has been to develop a useful computational tool for
predictions of the behavior and effectiveness of polymer composite-portland cement concrete
systems so as to select the proper repair/protective materials for a specific application. The
compatibility space can also be analyzed to help predict the properties that will be needed by new
materials.

Results of the project are presented in this report, and in the Compatibility Computer System
(CCS), whose User’s Manual has been published as an appendix to this report. A second appendix
contains a list of the 17 publications that were presented at international forums in English and
Polish and published in proceedings and journals during the project. The project’s results are in
general accord with worldwide scientific and engineering activities in repair materials. e.g., US
Research Program on Repair, Evaluation, Maintenance and Rehabilitation (REMR), European
Standard Activity on products and system for the protection and repair of concrete structures (ENV
1504 — pending) as well as the periodic meetings of the International Colloquium on Materials
Science and Restoration.

DISCLAIMER
Certain commercial equipment is identified in this report in order to adequately
specify the experimental procedure. In no case does such identification imply recommendation
or endorsement by the National Institute of Standards and Technology, nor does it imply that the
equipment used is necessarily the best available for the purpose

it
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1. INTRODUCTION

New developments in civil engineering and growing industrial activities create a continual demand
for building materials that must satisfy increasingly stringent requirements [1]. Ordinary portland
cement concrete is a ready-to-use, widely available building material, but its low durability under
many service conditions seems to be the price paid for its universality [2]. Polymer composites
appear to be useful protective and repair materials. They could be a valuable means to enhance the
durability of portland cement concrete exposed to the action of aggressive factors. The repair and
anti-corrosion protection of a building structure are two of the most important applications of
polymer composites [3-5]. They can be considered as high performance repair materials for portland
cement concrete structures, usually used under severe service conditions [6]. Surface repair, partial
depth repair, full depth or structural repair, and strengthening are typical examples of application. A
two component system - portland cement concrete (substrate) in contact with a polymer composite
(repair) - is produced in a typical repair situation. Lack of understanding of the polymer composite
(PC) — portland cement concrete (CC) interaction is frequently the source of failure in practice. The
compatibility of PC — CC systems is the main problem that was considered in this study [7-8].

The scientific aim of the study was to improve understanding of the PC-CC system, and in
particular, the compatibility between the two sub-units. From the engineering point of view, the aim
was to produce a useful tool for predicting the behavior of the two-component PC-CC system and
its durability, as well as for selection of the proper repair/protective material for a specific
application.

It should be noted at this point that the methodology used, and the software tool developed
using this methodology, in no way precludes the use of concrete substrates other than those based
on portland cement concrete. So we could use the term “cement concrete substrate” throughout this
report, rather than “portland cement concrete substrate.” However, since the work described in this
report was confined to portland cement concrete substrates, we use the latter terminology. In
addition, in the methodology used, the repair system was assumed to be a two-component system —
repair material and substrate material. Repair is often considered to be a three-phase system —
substrate, repair material, and a transition zone between them. By using interlayer adhesion or bond
strength as a material control parameter (see Sec. 2.2), this transition zone is implicitly included in
what is nominally only a two-phase repair system.

2. BASIC APROACH
2.1 Serviceability

Material serviceability in construction must be considered in light of the various requirements that
are defined by environmental service conditions. These requirements determine the mathematical
space of loads, including chemical, mechanical, and physical (mainly thermal) loads. The
interactions among the kinds of material properties required to sustain given loads define the
subspace of material serviceability, as is shown schematically in Fig.1. Region I is the region where
the material used can sustain the system loads, producing good serviceability.



ENVIRONMENTAL SERVICE CONDITIONS

Service Load Space:

Ch - chemical load
Me - machanical load
Th - thermal load

N - fallure subspace
Hl - fracture subspace

Figure 1. Environmental service conditions.

If the loads increase, as shown in Fig. 1, the failure (I) and fracture (III) sub-spaces are then
entered, reducing the service life and ultimately leading to failure. Repairs result in a two
component system: polymer composites — portland cement concrete. In this case, the situation is
even more complicated due to the compatibility problem. The two components must work together
to supply the load resistance that formerly only the concrete substrate provided. In engineering
practice, significant variability of the behavior of such a system is usually observed. Sometimes a
repair is reliable and durable. In other cases, failures occur after different periods of service time.
Different failure mechanisms possible for such a two-component system are shown schematically in
Fig.2. This problem of compatibility of repair materials with a portland cement concrete substrate
has been analyzed in this project, and the results summarized in this report.
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2.2 Definition of material control parameters

Concrete substrates differ in age and quality. Their condition before repair commences can vary
from only having a small amount of deterioration, all the way to severely deteriorated concrete.
Concrete substrates are also exposed to various temperatures, relative humidities, aggressive
chemical environments, and mechanical loads. There are two basic problems involved with the
usability of polymer composite repair materials and the durability of the system as a whole [9]:
(1) proper formulation of the polymer concrete to obtain a material with the properties that meet
requirements, which is a material design and optimization problem [10,11], and (2) the
compatibility of the system subunits, which is a problem of materials selection and evaluation of the
two-component system behavior [12]. Compatibility is an intuitive term, whose exact definition in
terms of material serviceability is given in Sec. 2.3. For now, it can be thought of as the interaction
of the material properties of the two component repair system during service.

Research into what is the proper formulation of the polymer composite repair material in
order to achieve given material properties has been carried out. An optimization program is available
for aiding this endeavor [10,11]. However, the compatibility of PC - CC systems is still a significant
and difficult problem [13,14], as has been stressed by other authors [15,16]. In all this work, the
concrete substrate is assumed to be given, and the proper repair material must then be selected for
the given substrate and service loads. This, of course, is the usual repair scenario, with repairs being
made only (hopefully) after the concrete substrate has been in place for several years.

On the basis of literature data [17] and recent research [18,19], the technical properties of the
polymer composite repair material and the concrete substrate that influence the PC - CC system have
been selected and their probable range of values have been defined. These are called the material
control parameters. The following properties, listed in Table 1, have been considered as the
material control parameters. These include: mechanical parameters such as bond strength, cracking
resistance, interlayer adhesion, and ultimate strength in glue joints, thermal parameters such as
setting shrinkage, thermal compatibility, thermal resistance including shock resistance, and chemical
resistance controlled by the mass transport process.

This set of requirements can be expanded. An additional parameter might be, for example,
the freeze-thaw resistance. An inequality characterizing the freeze/thaw resistance might be
expressed in terms of a balance between the water permeability and the tensile strength of the given
material (see Sec. 2.4). ‘



Table 1. Material control parameters for the compatibility of the polymer composite — portland

cement concrete (PC - CC) system

MATERIAL CONTROL PARAMETERS

Polymer composite

Portland cement concrete

RS - tensile strength, MPa

Ef - tensile elasticity modulus, MPa

ES - compressive elasticity modulus, MPa
o - linear expansion coefficient, K

2F - thermal conductivity, W/ mK

Vb - Poisson's coefficient

g - ultimate tensile strain, %
ef - linear shrinkage, %

D - diffusion coefficient, cm’s?

R P® . PC-PC interface shear strength, MPa
h, - thickness, m
Iy - length of substrate crack covering layer, mm

t - time of penetration, s

- compressive strength, MPa

- tensile strength, MPa

- tensile elasticity modulus, MPa
- linear expansion coefficient, K
- thermal conductivity, W/ mK

- thickness, m

- crack width, mm

- maximum possible crack width

change, mm

R P _ interface shear strength, MPa
Rp,P'B * _ interface tensile strength, MPa

AT —temperature gradient during service, K

* For injection and glue joints




2.3 Approach to the compatibility concept

The basis for repair material selection has been changing over time. In the past, “repair of materials
only by similar materials” was the rule used. It should be stressed that “similarity” meant only
material similarity, i.e., only cementitious materials should be used for repairing cementitious
substrates. D. Plum in 1990 stated, as well as have other authors, that this concept is not logical
[20]. At present, the repair material selection rule has been to have similarity of the technical
properties. However, the problem of selecting a proper repair material still remains a difficult one.
There is a great need to develop a computer-based tool, similar to that for polymer concrete
optimization [10,11], that can be used to predict the behavior of the complete repair system and to
select the proper polymer composite repair material for the given application.

The boom in new building products since the beginning of the 1990’s has spawned many
new polymer-mineral composites and, as a consequence, the situation of “embarasse de richesse.”
Common questions that often arise concerning these repair materials include “how to select ?” [21],
“according to which criteria 7’ [22], and, not surprisingly, “why do they fail 7 [23]. In 1997 the
European pre-standard ENV 1504-9: 1997 “Products and systems for the protection and repair of
concrete structures” formulated the general principles of the problem. The standard defines a matrix
of 90 material properties multiplied by 26 repair methods. This demonstrates how complicated the
problem can be.

In 1991 L. Czamecki et al. [24], and in 1992 P. Emmons et al. [25] presented some
compatibility problems in choosing repair materials. Following the discussion at the International
Colloquium in Esslingen, entitled “Material Science and Restoration,” the precise meaning of the
term compatibility has become more precise. Compatibility is defined as selection of the elements of
the repaired system, according to chemical and physical properties, to ensure that the acceptable
mechanical stresses (in some cases also the deformations) are not exceeded in any part of the system
during the predicted service life under the prevailing use conditions. We note that mechanical
stresses are what damage materials, but these stresses can come from loads other than mechanical
ones. This definition has been basic to the present study.

2.4 Assumptions of compatibility models

If a repair material and a portland cement concrete substrate work well together, performing the
function intended for an acceptable service life, we say that the materials have good compatibility
or are compatible. The requirements for good compatibility between polymer composite repair
materials and a portland cement concrete substrate can be formulated using mathematical
inequalities, where the variables are the material control parameters. The important material
control parameters are listed in Table 1. When the material control parameters are selected, their
ranges must also be defined for a given repair system. Materials that satisfy these inequalities
should result in a repair that has a proper equilibrium among reliability, durability and economy.

These mathematical inequalities have been formulated using assumptions that were made to
keep the compatibility model sufficiently accurate yet simple enough to use easily. These
simplifying assumptions include: validity of Hooke's law, lack of synergistic effects of various loads
(loads acts in a linearly additive fashion), and service temperature always below the glass transition
temperature of the polymers used.



The mathematical inequalities that define the compatibility of the polymer composite -
portland cement concrete system are listed in Table 2. They define the compatibility requirements
for: crack resistance (Eq.1), crack-bridging ability (Eq.2a — already-cracked substrate and Eq.2b —
cracking may occur in uncracked substrate), adhesion to concrete substrate in shear (Eq.3a) and
tensile (Eq.3b) conditions, interlayer adhesion of repair material (Eq.4), thermal compatibility
(Eq.5), stress compatibility (Eq.6), resistance to thermal shock (Eq.7), shrinkage stress resistance
(Eq.8a-8c¢), and diffusion resistance of the coating (Eq.9).

An N-dimensional mathematical space is defined by the N different material control
parameters for the repair system and their allowable ranges. Within this space, if there is a region
in which the inequalities are satisfied, this region is called the “compatibility space” that
determines the requirements for compatibility in a PC-CC system. This sub-space must be
calculated. If N is bigger than 1 or 2, a computer program must be used because of the
complicated nature of the problem. For example, a 12-dimensional (N=12) compatibility space
must be evaluated for anti-corrosion protection by a polymer composite coating. This approach is
flexible, and can be applied to many different types of materials. How to determine the
compatibility space is discussed in the next section (Sec. 3.1). Once a compatibility space is
determined, its predictions can be compared to experimental data, and the predictability of the
model analyzed. Appropriate validation will provide a technical basis for the selection of polymer
repair materials, which should result in durable repairs.



Table 2. Mathematical inequalities that determine the compatibility of the PC-CC system
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3. COMPATIBILITY SPACE SEARCH METHOD FOR POLYMER COMPOSITES
AND PORTLAND CEMENT CONCRETE

3.1 Main idea of the project

The material control parameters and controlling the PC — CC system have been defined in Sec. 2.2
and listed in Table 1. The compatibility of the polymer composite — portland cement concrete
system has been characterized by mathematical inequalities involving these parameters, as listed in
Table 2. The models developed in this work are then based on calculating the compatibility space of
the two kinds of materials, which is the region in the N-dimensional material control parameter
space in which the inequalities of Table 2 are satisfied.

Determining this compatibility space involves searching for this space by sequential substitution
of suitable material property values, chosen from the range of values that occur in practice and
satisfy the allowable ranges (chosen for each problem). Although many kinds of repair can be
considered, each with its own parameter and compatibility space, we have only considered three
types of models for three kinds of repair systems. These three choices are shown schematically in
Fig.3 and are: model I — crack injection, model II — structural surfacing, and model III — coating
application. Figure 3 clearly shows the difference between structural surfacing and a simple coating
application. The actual material control parameters and their allowable ranges used for these models
are shown in Table 3. The reader is reminded that material control parameters are chosen for both
the polymer concrete repair material and the portland cement concrete substrate that is being
repaired.

For each repair case, the following procedure, shown schematically in Fig. 4, was carried out.
First, the important material control parameters were chosen from the list given in Table 1. Second,
the inequalities were chosen that apply to the problem. These were chosen according to the type of
concrete failure anticipated and the type of repair that was made. The compatibility space was then
determined with our Compatibility computer program (see User’s Guide in Appendix 2), and the
results were experimentally verified. The validated Compatibility program was then used to
calculate new compatibility subspaces defined by various properties of the concrete substrate and the
repair materials, and according to various application options (variable thickness of coating on the
concrete, range of temperature changes, etc.). Thus new repair options can be studied by virtual
analysis, within the range of the three cases investigated, using the Compatibility computer program.
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Figure 3. Schematically showing the three kinds of repair situations/models considered in this work,

along with an outline of the approach to the basic problem.
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Table 3. Material control parameters — boundary ranges (see Table 1 for parameter definitions)

No. Symbol, units Application range
crack injection structural Coatings
surfacing

1 R.>MPa 4.50 — 6.00 4.50 - 6.00 4.50 - 6.00
2 R, MPa - 4.50 - 15.00 4.50-15.00
3 R®, MPa 2.60 — 60.00 5.00 —40.00 8.00 — 60.00
4 Epr Gpa 0.20 — 8.00 4.00 —26.00 0.20 - 26.00
5 ep— 107 0.35-2.80 0.04 -1.70 0.10 - 40.00
6 eps— 107 0.10 — 18.00 0.05-3.00 0.05—13.00
7 Ap 0.12-0.35 0.07 - 0.45 0.12-0.45
8 D-10? - - 0.50 —7.00
9 t, years - - 0-10

10 hp — 107 <0.30 0.30-10.00 0.20 —2.00
11 ar =107 K 2.00 —12.00 1.00-9.00 1.00 — 12.00
12 a 1-3 1-3 1-7

i1




POLYMER COMPOSITE AS A REPAIR MATERIAL —
COMPATIBILITY PROBLEM

MATERIAL CONTROL PARAMETERS

v

R — interface shear strength

AT - temperature difference R, — compressive strength

R,; — tensile strength

R, — tensile strength
R.P?P — PC-PC interface shear

strength E,, — tensile elasticity modulus
E,; - tensile elasticity modulus TYPE OF CONCRETE FAILURE o, — linear expansion coefficient
Spalling

€p, — Ultimate tension strain

a, — crack width

Iy — bond length

1, — length of concrete decrement

E, — compressive elasticity
modulus

o, — linear expansion
coefficient

€pr — Ultimate tension strain
gg ~ linear shrinkage

v, — Poisson’s coefficient
h,, - thickness of PC layer

EXPERIMENTAL VERIFICATION OF
N-DIMENSIONAL SPACE OF COMPATIBILITY
OF PC-CC SYSTEM

epsP [on/onle-2

Figure 4: Schematic outline of work of the repair material compatibility project
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3.2 General structure of Compatibility computer program

The three repair models studied are mathematically described by a set of suitable linear and non-
linear inequalities, taken from those given in Table 2, which are the requirements of compatibility.
The material control properties of the polymer composites and the portland cement concrete
substrate are the variables of the inequalities. Determination of the compatibility space is done by
solving the set of inequalities by successively ascribing all possible values (X, X3, ..., Xq) of the
material control properties. The solution of the set of inequalities defines the N-dimensional
compatibility space. This solution is a complicated and time-consuming process for more than 1 or 2
variables. The Compatibility computer program has been developed for the determination of the
compatibility space. The program consists of three calculation procedures: BASIS, VERIF,
EXPAND, and two graphic procedures: GRAPH-2D and GRAPH-3D, as described briefly below
(see Appendix 2 for the complete User’s Guide).

BASIS: analysis of compatibility space at boundary conditions (or nodes, defined in Fig. 5), which
is where the minimum and maximum values of the materials control properties occur.

VERIF: supplementary procedure to the procedure BASIS, and used in the case when the nodes of
the space determined in procedure BASIS are not solutions of the set of inequalities. The procedure
is used to check if points between the nodes of the space determined by the BASIS procedure
satisfy the inequalities (see Fig. 5).

EXPAND: the most important program procedure, which is used for determining the N-dimensional
parallelipipeds belonging to the common parts of the solution of the set of inequalities. These N-
dimensional regions are obtained by building up the space defined by the nodes determined in the
BASIS or VERIF procedures. '

GRAPH-2D and GRAPH-3D: procedures used for graphical presentation of two and three
dimensional subspaces of the compatibility space.

13
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Figure 5. The solution space formed by three variables: x;, X2, X3

3.3 Examples of compatibility space for the selected models of PC-CC system

It is important for the reader to get a “feel” for what compatibility spaces look like, and how
their shape and size are affected by changes in the material control parameters. To facilitate this
intuition, some examples of compatibility spaces for the three basic PC-CC system models
considered are presented in Figs. 6-8. For each figure, parts a) and b) show how the compatibility
space (or subspace, terms used interchangeably) can change when one material control parameter is
varied. The factors used were repair type (injection, structural surfacing, anti-corrosion coating), the
quality of the concrete substrate, the permissible width of cracks in the coating, and changes of the
temperature during service.
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Figure 6. Example of a 3-D compatibility subspace for a polymer composite and portland cement
concrete of B25 class (a) and B50 class (b) in the case of crack injection for a service
temperature change of AT = 20 K, where Bn means a compressive strength of at least n MPa.
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Figure 7. Example of a 3-D compatibility subspace for a polymer composite and portland cement
concrete in the case of structural surface repair of the non-cracked substrate for service

temperature changes AT, of : (a) 20 K and (b) 40 K
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Figure 8. Example of a 3-D compatibility subspace for a polymer composite and portland cement
concrete in the case of an anti-corrosion coating protection of the concrete substrate, where crack
widths of: (a) 0.1 mm and (b) 0.2 mm were considered acceptable, for a service temperature

change of AT = 20K.
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4. VERIFICATION TESTS OF THE COMPATIBILITY OF VARIOUS POLYMER
COMPOSITE — PORTLAND CEMENT CONCRETE SYSTEMS

4.1 Verification approach

The compatibility spaces obtained by computer calculation must be verified by experiment to prove
the adequacy of the compatibility models for the PC-CC system. One way to carry out this
verification process is by testing to determine the adhesion between polymer composites and the
portland cement concrete substrate. Adhesion testing is used because it is the most common failure
mode for polymer composite repairs of portland cement concrete substrates. The methods of testing
recommended by RILEM Technical Committee TC 52 - RAC and TC 113 - CPT were used to
determine the adhesion between the portland cement concrete substrate and selected types of
polymer composite repair materials. Some other test methods recommended by RILEM TC 113 -
CPT for PC-CC systems were also used. These test methods are described in more detail in the next
section. Cases of compatibility and incompatibility have been used to validate the Compatibility
program. Section 4.2 describes the various test methods used, while Sec. 4.3 describes the
systematic verification of the compatibility models for the three kinds of repairs considered.

4.2 Adhesion test methods

4.2.1 Pull off test

This method tests the adhesion of coatings with thickness ty applied on dry or wet concrete.
Adhesion is measured in terms of the tensile stress required to remove or cause failure of a
cylindrical section of the surface coating that has been isolated from the surrounding coating. The
load should be applied at a stress rate of 0.1 N/mm? s™ until failure occurs. The test configuration is
shown schematically in Fig. 9. The maximum tensile stress and failure mode were determined. A
minimum of five test spots were prepared on one or more concrete substrate specimens, as is shown
in Fig.10.

The possible failure modes are shown in Fig.11. These failure modes are: A = cohesive
failure within the concrete substrate, A/B = adhesion failure between the coating and concrete
substrate, and B = cohesive failure within the coating. In the case of the A/B or combined failure
mode, the share of each mode of failure shall be estimated as 25 %, 50 % or 75 %. If failure occurs
at the interface between the piston and the coating, the test should be run again, as this result is not
an acceptable outcome.

17
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Figure 9. Test configuration; t min =100 mm, f; min = 50 MPa; aggregate grain max diameter =16 mm,
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Figure 10. Examples of spacing the test sites on a specimen, dimensions in mm.
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Adhesion between polymer composites and a concrete substrate can be determined also by
measuring the tensile strength in a uniaxial test. The test specimen consists of two halves of a
concrete sample, bonded together by the repair composite material to be tested, as shown
schematically in Fig.12. This test can be useful in the case of injection composites as well as high
clastic sealing composites.

A
concrete
z
————
NG ~
22.5 mm 22.5 mm
B
glue
A 4

Figure 12. The specimen shape for adhesion determination by a uniaxial tensile test

4.2.2 Dynamic loading test
The aim of this test is to determinate the adhesion of a polymer composite that is cured under

dynamic loading. This test is an attempt to simulate the situation prevailing in a repair of a concrete
bridge while under traffic load. Figure 13 shows the details of the test specimen used. The dynamic
loading forces are applied under the following conditions: distance of loading points from the
bearing = 350 mm, size of load = 8 kN - 40 kN, the frequency of variation of loading = 4.2 Hz, and
the duration of loading = 24 h. After the duration of the test, the repair material is visually inspected
for cracks and delamination from the concrete substrate.
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repair material

280

5

0-0

Figure 13. Geometry and scheme of loading concrete beam after repairing, dimensions in mm.

1,2,3 — reinforcement shown in bottom half of figure.

4.2.3 Slant shear test

This test determines the bond strength of polymer-based repair materials to portland cement concrete
in a slant shear geometry. The bond strength is determined on a composite prism, as is shown in Fig.
14. After suitable curing the test is performed by applying a compressive force on the composite
prism. The test is used for the following combinations: old concrete glued to old concrete, fresh
concrete glued to old concrete, and repair material glued to old concrete with or without a primer.
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Figure 14. Geometry and shape of the slant shear test specimen, dimensions in mm. Surface area of
section 100 mm x 100 mm.

The load at rupture and the mode of failure is recorded. Possible failure modes are: normal
type of rupture as found in non-composite cylinders or cubes, or rupture following a slide plane that
more or less coincides with the slant plane. In this case an estimate has to be made of the kind of
failure, to the nearest 25 % of the different materials and interfaces: A = cohesive failure within the
concrete substrate, old or new, A/B = adhesive failure between primer or glue and concrete, old or
new, and B = cohesive failure within the glue or primer.

4.2.4 Direct shear test

The aim of the direct shear test is the determination of the shear bond strength of bonded prisms,
which represent various kinds of composite joints. Figure 15 shows a schematic view of the test ,
specimen used. A bonded prism is tested in a compressive test machine and the joint is thus subject
to a combination of shear, tensile and compressive stresses, whose ratio depends on the thickness of
the bond layer , t, and the stiffness of the adhesive.
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cohesive failure within the adhesive.

The strength and the mode of failure is recorded. The possible failure modes are shown in

Fig.16: A = cohesive failure within the concrete substrate, A/B = adhesive failure between the

adhesive and concrete substrate, and B
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Figure 16. Modes of failure for direct shear test.
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4.2.5 Thermal compatibility tests
These tests determine the thermal behavior of a polymer composite coating covering a portland
cement concrete substrate.

Thermal compatibility test (I)
The thickness of the polymer coating should be at least 0.1 mm. The behavior under freeze-thaw

conditions as well as under thermal shock can be tested. The minimum dimension of the concrete-
coating interface should be in accordance with the number of tests to be performed on one concrete
specimen (cube or slab), but not less than 200 mm. The thickness of the substrate should be at least
100 mm. The quality of the concrete substrate specimen should be such that the cube compressive
strength is at least 50 MPa after 28 d. Concrete shall be prepared from aggregates having a
maximum grain size of 16 mm. The concrete substrate may be wet or dry according to the type of
coating. In the standard case, the side faces of the coated specimen shall not be sealed. If the field
application does not correspond to unsealed joints the side faces may be sealed in the test. The
freeze-thaw cycles as well as the thermal shock shall be carried out in two steps on different
specimens.

In the freeze-thaw test, the specimens are alternately submerged for one hour each in water of
(20 £ 2) °C and in a salt-water solution of approximately (18 + 2) °C (see Fig. 17a). The cycling
begins with normal temperature immersion and lasts 200 h (100 cycles). The specimens should
always be put in a vertical position, as is shown in Fig. 17b.

b)
temp., a) _
+20°C
v time, h
-18 7
1h 1h 1h concrete with coating
4—P PP
1 cycle water/salt water

Figure 17. Freeze-thaw test: a) cycle configurations, b) placement of specimen

In the thermal shock test each thermal shock cycle consists of a heating phase for six hours in
air at a temperature of (60 £ 2) °C and (95 % S5) %RH, followed by a 10 minute-long artificial rain
shower (total water volume applied of about 30 L/min to 40 L/min with a water temperature of (10 £
2) °C. The complete thermal shock test lasts 50 cycles (see Fig. 18a). During the artificial rain
shower the specimen should be placed in a horizontal position on an iron lattice support, as is shown
in Fig. 18b. A sprinkler nozzle is fixed a distance of 300 mm - 500 mm above the coated surface.
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The coating is visually evaluated after each cycle, noting any delamination, cracks, bubbles or other

failures. After the test cycles are completed the samples are subjected to the pull-off test (see Sec.
4.2.1).

temp., °C

+60
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»
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P

Figure 18. Thermal shock test: a) cycle configuration, b) placement of specimen.

Thermal compatibility test (II

This test defines the procedure for the determination of the adhesion of coatings with thickness up to
10 mm. Adhesion is measured in terms of the tensile stress required to remove or cause failure of a
cylindrical section of surface coating that has been severed from the surrounding coating.

The minimum dimensions and shape of the concrete substrate specimen should be in
accordance with the number of tests to be performed on one concrete specimen (cube or slab), but
not less than 200 mm. The thickness of the substrate shall be at least 100 mm. The quality of the
concrete substrate specimen shall be such that the cube compressive strength is at least 50 MPa after
28 d. The concrete should be prepared from aggregates having a maximum grain size of 16 mm. The
concrete substrate can be wet or dry according to the type of coating. Three test specimens are
required for tests on the dry support, three more for the tests on the wet support. Before the test,
specimens should be placed for a minimum of 24 hours in standard laboratory conditions at (20 + 2)
°C and (65 + 5) %RH. In the standard case, the side faces of the coated specimen are not be sealed.
If the field application does not correspond to unsealed joints, the side faces may be sealed in the
test.

The thermal cycles carried out are illustrated in Fig. 19, with a total of 100 cycles. The
coating should be visually evaluated after each cycle, noting any delaminations, cracks, bubbles or
other failures. After the test cycles the samples shall be subjected to the pull-off test (see Sec. 4.2.1).
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Figure 19. Thermal cycles for thermal compatibility test II.

4.2.6 Four-point bending test
This test is recommended for determination of the adhesion of coatings with thickness up to 10 mm

on a concrete substrate. The principle of the test consists of applying the polymer composites filling
a recess made on one of the surfaces of a prismatic concrete test piece (Fig. 20) and subjecting the
specimen to a four point bending strength test.

200 mm ’l

"__i_lOmm

100::1_:/'1 F L

l< 180 mm »I

100 mm

400 mm »l
g

Figure 20. Geometry of specimen for four-point bending test

The quality of the concrete substrate specimen should be such that the cube compressive
strength is at least SO MPa after 28 d. The concrete should be prepared from aggregates having a
maximum grain size of 16 mm. The system with the coating in place should be conditioned for
seven days in standard laboratory conditions at 20 + 2 °C and 65 + 5 %RH.

During mechanical tests, the filled side of the specimen is placed on the bottom support
(tension side of the specimen) of the loading apparatus, as is shown in Fig. 21. The rate of loading
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should be constant during the whole duration of the test and equal to 0.05 MPa/s with a tolerance of
0.01 MPa.The strength and the mode of failure must be recorded. The possible modes are shown
in Fig.22, which define whether a repair is compatible or incompatible.

hardened concrete

repair mortar; thickness = 10 mm

Figure 21. Sample arrangement for 4-point bending test.
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T
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Figure 22. Modes of failure. Compatibility evaluation: 1,2 — compatibility; 3, 4, 5 — incompatibility.
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4.3 Determination of adhesion between concrete substrates and selected types of repair
composites

The previous section described the kinds of adhesion testing that was used in the validation program.
Not all tests were performed on all samples. Preliminary adhesion testing was carried out to obtain
knowledge of what were some of the important variables, and as a qualitative check of the
inequalities and material control parameters that were built into the program. Specific tests were
then carried out and compared directly to the predictions of the Compatibility program.

4.3.1 System characterization — preliminary tests
Preliminary tests of adhesion between polymer composite repair materials and portland cement

concrete substrates have been carried out for five types of repair systems (Table 4): I) polymer
modified cement composites (concrete or mortar), II) polymer-cement composites (concrete or
mortar), II) polymer composites (concrete or mortar), IV) injection polymer composites (non-filled
composites), and V) high elastic polymer composites (non-filled composites). Only substrates of the
B25 class were used in this preliminary testing. The designation “B25” means that the compressive
strength was at least 25 MPa at 28 d.

Table 4. Basic technical properties determined for particular repair composites

(at strain of 50%)

Type of composites Workability Linear Compressive Flexural Tensile strength Adhesion, MPa
time shrinkage strength strength MPa intension | in shear
min % MPa MPa
I) polymer modified
cement mortar 30 0.04 54.2 16.7 - 1.6 5.6
1) epoxy-cement mortar
50 0.03 41.6 274 - 2.2 6.6
IIT) vinyl-ester concrete
30 0.23 71.2 28.6 12.8 3.6 12.3
IV) polyurethane
injection composite
- non-foamed
 foamod, 1.5 0.25 79.0 78.1 2.3 2.7 9.8
2.0 0.90 25.1 9.6 24.6 1.2 3.2
V) high elastic
polyurethane composite 100 0.60 1.6 - 1.1 0.9 1.0

The adhesion between concrete substrates and various types of repair composites was
determined for two cases (see Table 4). Case 1 was to test the adhesion in tensile conditions (loading
perpendicular to the composite-concrete contact zone) using a uniaxial tensile test for specimens
bonded by repair composites of types IV and V. The load at failure, divided by the measured value
of the cross sectional area at failure, was used to calculate the failure tensile stress. For repair
material types I and II, the pull-off test (see Sec. 4.2.1) was used. Case 2 was to test the adhesion
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between repair material and substrate in shear conditions (see Fig. 14 in Sec 4.2.3). The
combinations of old and fresh concrete substrates with repair material III, and two specimens of an
old concrete substrate bonded with repair material V, have been tested.

The results obtained, shown in Table 5, indicate that adhesion between polymer composite
repair materials and portland cement concrete substrates is sensitive to whether the substrate surface
was dry or wet, and whether a primer was used to promote adhesion between the two materials.
These results indicate the necessity of proper preparation of the concrete substrate.

The next sections describe the results of specific tests that were used to directly compare to the
Compatibility program results. A figure showing the test results as well as the compatibility
subspace is given for some tests, for the three kinds of situations studied: structural surfacing, crack
injection, and coatings. For some tests, only a picture of the experiment or the compatibility space is
given, but full results are given in the accompanying tables. In all cases, the prediction of the
Compatibility program, either compatibility or incompatibility, depending whether the material
parameters were inside or outside the compatibility space, were verified by the experimental results.

Note that the tests chosen for each situation corresponded to probable applications of the given
polymer composites.
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Table 5. Adhesion to concrete substrate of the particular types of repair composites

Type of composites Adhesion to concrete substrate
mean value, standard coefficient of Mode of failure Remarks
MPa deviation, variation,
MPa %

1) polymer modified cohesive failure within
cement mortar 1.6 0.15 1.6 composite
I1) epoxy-cement mortar cohesive failure within concrete

>3.0 - -- substrate
T1) vinyl-ester concrete cohesive failure within concrete

16.4 2.55 15.6 substrate
IV polyurethane injection wet concrete substrate results in adhesion
composite combined failure of adhesive- -
- non-foamed . ecreasing about 50% with hi iati
. ?::m:i © 1.3 0.29 22.3 cohesive type d sing about 50% with high variation of

1.2 0.36 29.0 results
V) high elastic
polyurethane composite: N
- in tensile conditi . . s adhesi i -
in tensile condition 0.90 011 12.3 cohesive failure within dhesion decreasing for non-cleaned substrate

- in shear condition . .. . .

1.00 0.12 12.0 composite and joint without primer
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4.3.2 Laboratory verification of structural surfacing predictions

Three types (A, B, C) of epoxy and two types (D, E) of acrylic repair composites have been used
in the full test program, which included thermal and freeze/thaw tests. A summary of the final
results has been presented in Table 6 and illustrated in Figs. 23-30. The results obtained
confirmed the practical usefulness of the Compatibility program to accurately evaluate the
In Table 6, C =

compatibility of repair materials and substrates in this repair situation.
compatible, IC = incompatible.

Table 6. Measurement of the adhesion of the repair materials to the concrete substrate

Thickness of o Flexural
Repair ) Compatibility
Test concrete loss Mode of failure ) strength,
material evaluation
[mm] MPa
15 C; see Figs. 9.2
Bending
A 30 23 &24 9.7
Bending + 30 IC; 62
thermal cycle C see Fig. 25 ‘
15 IC; see 8.3
B Bending )
30 Figs. 26 & 27 6.7
15 11.2
Bending
30 113
C { C
Bending +
30 13.0
thermal cycle
15 IC;
D  |Bending i 6.4
see Fig. 28
15
i C 5.6
Bending 30 cic
5.4
E __AJ A— see Fig. 29
ding + G
bending 30 . 16
thermal cycle see Fig. 30
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Figure 23. Fracture of the beam with a loss of 30 mm depth of substrate, filled by type A repair
material.
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Figure 24. Compatibility subspace for the portland cement concrete substrate and repair material
A, where the axes are modulus of elasticity, adhesion to concrete and ultimate strain. The
marked point (not shown) corresponds to the properties of repair material type A, which is inside
the compatibility space.
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Figure 25. Compatibility subspace for repair material A and the portland cement concrete
substrate under thermal load. The axes of the subspace are modulus of elasticity, adhesion to
concrete and ultimate strain. The marked point corresponded to the properties of repair material
type A, which fell outside the compatibility space.
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Figure 26. Fracture of the beam with a loss of 30 mm depth of substrate, filled by type B repair

material.
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Figure 27. Compatibility subspace for repair material B and the portland cement concrete
substrate under thermal load. The axes of the subspace are modulus of elasticity, pull-off
strength, and adhesion to concrete in shear condition. The marked point corresponds to the
properties of type B repair material, which fell outside the compatibility subspace.
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Figure 28. Fracture of the beam with a loss of 15 mm depth of substrate, filled by type D‘repair
material.
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Figure 29. Compatibility subspace for repair material E and the portland cement concrete
substrate under thermal load. The axes are pull-off strength, adhesion to concrete in shear
condition, and tensile strength. The marked point corresponds to the properties of type E repair
material, which fell outside the compatibility subspace.
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Figure 30. Fracture of the beam with a loss of 30 mm depth of substrate, filled by type E repair
material.

4.3.3 Laboratory verification of coatings on portland cement concrete

4.3.3.1 Materials and test methods
The polymer (acrylic) cement coating has been evaluated according to the full test program,
including thermal and freeze/thaw tests.

The main part of the laboratory work has included the testing of protective coatings covering
reinforced concrete beams (100 mm x 100 mm x 500 mm). The beams had been stored at a
temperature of (20 + 2) °C and 100 %RH for 28 d, after which the tested coating was applied to
the beam surface. The repaired beams and plates were then kept at (20 * 2) °C and 65 %RH. The
bending tests have also been carried out for the repaired beams after 25 thermal cycles (360 min
at +50 °C and 15 min at +10 °C). The beams have been tested freely supported, loaded by two
concentrated forces placed at 1/3 of the span. The destructive force and the failure mode
(adhesive-delamination, cohesive in the concrete, cohesive in the coating) were determined.

The properties of the coating and the concrete were determined in a complementary part of
the testing. The samples of concrete (150 mm cubes for mechanical strength and 50 mm x 250
mm x 250 mm plates for adhesion tests) have been stored in the same way as were the beams.

4.3.3.2 Test results and analysis

The compressive strength of the concrete ranged from 33 MPa to 48 MPa, and the tensile
strength ranged from 2.0 MPa to 4.0 MPa. The values of the properties of the coating, important
for their compatibility, were also determined (Table 7).
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Table 7. Properties of the coating material

Material h Rrp/b Rprp"J Rpr Epr Qlpr Es €pr
[mm] | [MPa] | [MPa] | [MPa] | [MPa] | [1/K] [%0] [%]
Storage at normal condition
MP-1 2.8 1.77 |45 6.2 109.5 [2.9-10° [0.25 4.2
After 25 freeze/thaw cycles
MP-1 2.9 139 4.1 6.4  [154.0 [2.9-10° ]0.25 3.2

R.”” — adhesion to the concrete substrate at shear
R, — adhesion to the concrete substrate at tension (pull-off)
Ry: — tensile strength

Epr — modulus of elasticity at tension
a,pr — thermal expansion coefficient
gs — hardening shrinkage
€pr — maximum elongation at tension
h — coating thickness
1) — destruction in the concrete and coating (cohesive failure, no delamination)
2) — destruction between coating and concrete substrate (adhesive failure; delamination)

The freeze/thaw test was the decisive factor that classified materials into incompatibility and
compatibility classifications. All the beams covered by a tested coating failed as a result of a crack
across the concrete and coating. Delamination was not observed. Figure 31a shows a coated beam
that had such a failure mode. Adhesive failure was only found for the beams tested after the freeze-

thaw cycles. An example is shown in Fig. 32a.

The compatibility space was determined on the basis of the material control parameters for

the coated systems. The compatibility subspaces corresponding to Figs. 31a and 32a are shown in
Figs. 31b and 32b, respectively. A crack with a potential maximum width of 0.2 mm has been

implemented into the compatibility model.

The results of laboratory tests (Fig. 31a, 32a) have shown good conformity to the theoretical
calculations (Fig.31b, 32b). Cohesive failure with no delamination clearly corresponds to the
compatibility stage, while adhesive failure, accompanied by delamination of the coating,

corresponds to the incompatibility stage, as expected.
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Figure 31. Cohesive failure in the crack zone for a coating stored at normal conditions (a) and the
compatibility subspace (b). The marked point is inside the compatibility subspace, predicting
compatibility of the coating/substrate system.
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Figure 32. Adhesive failure with coating delamination after freeze/thaw test (a) and the compatibility
subspace (b). The marked point is outside the compatibility subspace, predicting in compatibility of
the coating/substrate system.
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4.3 .4 Laboratory verification of crack injection repair situation and materials

4.3.4.1 Materials and test methods

Four injection materials, available commercially, were selected for testing: a three-component
cement-polymer material ICP-1 (w/c = 0.6), a two-component polyurethane resin IP-2, and two-
component epoxy resins IP-1 and IP-3. The main part of the laboratory work consisted of
flexural testing of reinforced concrete beams (100 mm x 100 mm x 400 mm) with artificially
formed cracks of 6 mm and 45 mm width (see Fig. 33 for the geometry), extending halfway
through the span. The beams were cured at (20 + 2) °C and 100 %RH for 28 d, after which the
cracks were injected with the tested materials. The repaired beams were then stored at (20 + 2) °C
and 65 %RH until testing. The bending tests were carried out for the as-cured repaired beams,
and also after 50 thermal cycles (360 min at +50 °C and 15 min at +10 °C) and after 25 cycles of
freezing and thawing. The beams have been tested freely supported, loaded by two concentrated
forces placed at 1/3 of the span. The load at failure and the failure mode (adhesive, cohesive in
the concrete, cohesive in the injected crack) were determined. The strain of the injection
materials in the crack was also measured using a tensiometer with a measurement basis of 20 mm
and accuracy of 0.001 mm. _

The separate properties of the injection materials and the concrete (materials control
parameters) were determined in a complementary part of the testing. The samples of concrete
(150 mm cubes for mechanical strength and 50 mm x 250 mm x 250 mm plates for adhesion
tests) were stored in the same way as the tested beams.

4.3.4.2 Test results and analvsis ,
The compressive strength of the concrete ranged from 33 MPa to 48 MPa, and the tensile

strength ranged from 2.0 MPa to 4.0 MPa. The values of the properties of the injection materials,
which were used as material control parameters, were also determined, both before and after the
freeze/thaw and thermal cycles, and are listed in Tables 8 and 9. We estimate the uncertainty in
all measured quantities to be approximately 10 %. Tables 8 and 9 also contain the test results on
the compatibility of the model crack injection repairs.
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Table 8. Properties of the injection materials before cycling

Material Rtp/b Rprp/o Rpr Ep Epr Olpr gs [%o0] €pr [%e]
[MPa] [MPa] |[MPa] |[MPa] |[MPa] [1/K]

ICP-1 09" <<4.0 |1.3 1235 - 2.2-10° |3.1 0.023

IP-1 >2.0% |>29 (359 1622 216 8.8-10” [0.45 18.2

IP-2 >1.79 |>3.1 0.3 - 2.03 - 4.8 39

1P-3 >16“7 [>20 12.8 2130 117 6.7-10” [0.36 28

R.P® — adhesion to the concrete substrate (pull-off test)

Rpr"/b — adhesion to the concrete substrate (bending of the injected beams)
Ry, — tensile strength

E, — modulus of elasticity at compression

Epr — modulus of elasticity at tension

apr — thermal expansion coefficient

gs — hardening shrinkage

€pr — maximum elongation at tension

1) — adhesive failure between injection material and concrete substrate

2) — cohesive failure in the concrete, beyond the place of binding

Table 9. Properties of the injection materials after thermal and freeze/thaw cycles

Material [R.”® [MPa] |Ry’~ MPa] {Ry [MPa] |E; [MPa] | Ey [MPa] | g, [%]
ICP-1[4) |[0.8 7 <<2.0 1.2 1018 - 0.020
IP-1 [3) |[>1.77 >32 37.6 1463 216 17.7
4 [>177 <41 36.3 1716 229 165
P2 |3) [>1.67 >3.2 03 |- 1.02 44
4 [>187 >2.9 0.1 - 0.221 33
IP3 [3) [>1.87 >332 139 1985 109 26
4) [137 <29 12.1 2091 122 22

3) — after 50 thermal cycles
4) — after 25 cycles of freezing and thawing
Other symbols as in Table 1
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The compatibility of the injection materials and concrete substrates was first analyzed using
a conventional classification, as given in Table 10.

Table 10. Conventional classification of bond effectiveness
between injection material and concrete

Assessment | Type of destruction | Description

]
A //f Ny /'/.é: Cohesive mode of failure;
Good i/ % 7 7 7 /Z A, B: sufficient adhesion of injection material to
AL

concrete on all planes of binding and sufficient

B W/ 7 J% tensile strength of injection material
Yl ’%

{
C ?{// 7 ’%C Adhesive mode of failure;
Insufficient 7/ 7 /{ j'j // /A C: insufficient adhesion of injection material to

concrete on one or two planes of binding
D: insufficient tensile strength of injection

B “7/%/ material
7 iy
2//%//,‘%

All the beams repaired with the polyurethane material IP-2 (30 specimens) failed as a result of a
crack across the concrete in the area above the place of injection. This is a cohesive mode of
failure, as is shown in Fig. 33a. The beams with a crack filled with the epoxy materials IP-1 (9
specimens) and IP-3 (14 specimens), tested at constant temperature, failed beyond the repaired
area. An example of an IP-3 specimen is shown in Fig. 33b. The samples repaired using IP-1 (6
specimens), tested after thermal cycling, failed in cross-section through the injected crack, as
shown in Fig. 34a. Adhesive failure was found for the beams tested after the freeze-thaw cycles,
repaired using IP-1 (6 specimens) and IP-3 (9 specimens), as is demonstrated for an IP-1
specimen in Fig. 34b. The adhesive failure mode was found for all the beams repaired with
material ICP-1.

The compatibility space was then determined on the basis of the material control parameters
and compared to experimental results. The results of laboratory tests have shown good conformity to
the theoretical calculations, as is be demonstrated below in Figs. 33-37.
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a) injection
with IP-2
material

b) injection
with IP-3
material

Figure 33. Examples of the failure of the injected beams: tests at constant temperature (IP-2 and
IP-3 materials)
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Figure 35 shows the compatibility space (three-axis view) for the IP-3 material, tested at
constant temperature (a), and for the IP-1 material after thermal cycles. Figure 35a corresponds
to Fig. 33b, which showed good compatibility. In Fig. 35a, the point marking the IP-3 material
properties lies inside the compatibility space. Figure 35b corresponds to Figs. 34a and 34b. The
marked point corresponds to the IP-1 material properties after thermal cycles, and lies outside of
the compatibility space, agreeing well with the kind of failures shown in Fig. 34.

The compatibility space for the IP-1 material, under normal conditions, is shown in Fig. 37a.
The marked point corresponds to the material properties of the IP-1 material at room temperature,
and lies inside the compatibility space. Figure 36 showed good compatibility for this system. It
is interesting to note that Fig. 37b shows the same system, but at a higher temperature. In this
case, the marked point lies outside the compatibility space, predicting that the failure would be
indicative of incompatibility in this case.
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a) injection with IP-1
material, tested after
50 thermal cycles

b) injection with IP-1
material, tested after
25 freeze/thaw cycles
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Figure 35. Examples of the compatibility space between injection materials and concrete:

a) The marked point corresponds to the properties of the IP-3 material, tested at the constant temperature. This

point is inside the compatibility space.
b) The marked point corresponds to the properties of the IP-1 material after thermal cycles. This point is outside

the compatibility space.
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Figure 37. Examples of the compatibility subspace between the IP-1 injection material and concrete

substrate under thermal load:

a) The marked point corresponds to the properties of the IP-1 material (tests under normal condition). This point is
inside the compatibility space.

b) The marked point corresponds to the properties of the IP-1 material (T = A40 °C). This point lies outside the

compatibility space.

4.3.5 On-site verification of repair material for surface protection of reinforced concrete tank
An actual field case was selected to further test and use the Compatibility program. This case fell

under the coating model, but with added inequalities involving corrosion, as the case studied was the
selection of a polymer coating for the anti-corrosion protection of a reinforced concrete tank at a
sewage plant. A set of 12 technical properties of the coating material, sufficient to define its
usability, was selected. The range of their values was determined and listed in Table 11.

The 2 mm-thick polyethylene foil PE-HD was predicted to be sufficient for the surface
protection of the concrete in the original project. However, this material solution has been found to
be time consuming and expensive. For this reason, a sprayed elastic coating has been proposed as an
alternative solution. Three polymer coatings with different technical properties and unit costs were
considered: Maxseal Flex, Poly-Pol and Icosit Elastic’. The concrete substrate of the tank is in the
B20 class, with a permissible crack width of a, = 0.2 mm, and range of service temperature changes
AT =30°C.
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Table 11. Range of values of the technical properties of coating composites used for surface

protection of concrete

Technical features of coating Unit Range of values
Interface shear strength, RP® MPa Rz + 10.0
Interlayer shear strength of coating, RF/P*! MPa 20-15.0
Tensile strength, Ry, MPa 2.0-60.0
Tensile modulus of elasticity, E, GPa 0.2 -20.0
Compressive modulus of elasticity, E, GPa 0.4 -30.0
Ultimate tensile strain, gy % 0.1-500
Linear shrinkage, € %0 0.05-13.0
Linear expansion coefficient, ou, K'x10? 1-12
Thermal conductivity A, W/ (mK) 0.12-1.50
Poisson's coefficient, vp - 0.20-0.40
Coating thickness, hy cm 0.1-2.0
Time of effective protection, t sx 108 0-3.16

The compatibility space was determined using a set of 12 inequalities. The allowable ranges
of the material control parameters within the compatibility space are given in Table 12. In previous
figures of a compatibility subspace, only part of the compatibility space, as defined by three of the
material control parameters, was shown. Table 12 in principle defines the complete compatibility
space.
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Table 12. Values of the material control parameters of the elastic coating compatible with the
portland cement concrete substrate (B20 class, a, =0.2 mm , and AT=30°C).

RP® RPP [ Ry Epr E; Epr &s Qpe Apr Vpr hy
MPa |[MPa |[MPa |GPa |[GPa (% % K 107 | W/(mK) cm
25~ |20- [4-60 [020- |0.40- [15-500 |0.005- |1.0-98 [0.39- |0.20- |0.1-2.0
100 [15.0 039 |3.28 0.15 1.50 0.40

The technical data from the producer of the selected elastic coatings indicates that all three

coatings have properties that fulfill the requirements of compatibility with the given B20 class
concrete substrate. On the basis of economy, the cheapest coating has been selected - Maxseal Flex.
A compatibility subspace for this material is shown in Fig. 38, essentially showing only three of the
ranges listed in Table 12. The cost of this coating is about one third that of the original coating. This
coating was then applied on the basis of this computation. After 1 year of service of this coating in
the tank, no failure has been observed. The more expensive material solution can be used in the case
of more difficult service conditions or concrete substrate with a higher compressive strength
(concrete class higher than B20).
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Rpk = 15,0 [MPa)
Rpzk = 1,35 [MPa]
Epr= 13500 [MPa])
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AT = 30 [°C)
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Figure 38. The compatibility space of a polymer repair material coating on portland cement
concrete. The marked point represents the properties of Maxseal Flex coating, which lie inside this

space.
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5. COMPATIBILITY COMPUTER SYSTEM (CCS) POSSIBILITIES

On the next pages 16 different compatibility subspaces (four each in Figs.39-42), obtained
using the Compatibility Computer System, are presented in order to show how complicated these
subspaces can be. Each figure is displayed exactly as in the Compatibility computer program (see
Appendix 2 for graphical details). In these figures, a red point indicates where a repair material is
incompatible with the substrate, while a green point indicates the material control parameters of the
repair material fell inside the compatibility subspace.

One should note that sometimes even a very small change of material properties for the
repair material used can change the compatibility conditions in unexpected ways. The opposite
situation has also been observed. In some cases, quite a large change of a repair material property
surprisingly does not affect the compatibility conditions significantly. Of course, using assumptions
like potential crack initiation, crack movement and a gradient of temperature also can change the
shape of the compatibility space in various ways.

The numbers accompanying each of the figures in Figs.39-42 give all the properties of the
concrete substrate and the repair material. This allows one to analyze the factors that create the
transition from compatibility to incompatibility (and vice versa), as well as to observe the
compatibility subspaces defined by a choice of three different material parameters (with all the other
parameters kept constant). A special computer program window can show those inequalities that are
not fulfilled in the incompatibility stage (see Appendix 2: User’s Guide). These four color figures
illustrate the method for, and the risk of, changing a material control parameter, as well as the effect
of these kind of changes on the compatibility of the repair system. This is helpful in using the
Compatibility program to predict desirable properties of new materials.

Figure 39 shows compatibility subspaces from the model discussed in Sec. 4.3.2, structural
re-surfacing. The substrate was uncracked. The four parts of the figure show the same compatibility
subspace, but using different axes each time, with all other variables held constant. The temperature
gradient, which is how much the temperature is expected to change during service, was AT =20 °C.
All four graphs show compatibility between the repair material and the substrate. The reader should
remember at this point that compatibility depends both on the repair material and the substrate
properties.

Figure 40 shows compatibility subspaces from the model discussed in Sec. 4.3.2, structural
re-surfacing, again for an uncracked substrate. The four parts of the figure show the same
compatibility subspace, but using different axes each time, with all other variables held constant.
The temperature gradient, which is how much the temperature is expected to change during service,
was AT = 40 °C. All four graphs now show, as compared to Fig. 39, incompatibility between the
repair material and the substrate.

Figure 41 shows compatibility subspaces from the model of a coating on a smooth substrate,
discussed in Sec. 4.3.3. The top two graphs are for a cracked concrete substrate, while the bottom
pair of graphs are for an uncracked substrate, in which cracks can initiate. From left to right, both
the value of a, and Aa,, which are the crack width and the maximum amount the crack width can
change, respectively (see Table 1), are increased by a factor of three (ar and dar on the graph).
Notice the changes in the shape of the subspace, and the change from compatibility to
incompatibility in the bottom two graphs.

Figure 42 shows compatibility subspaces from the model of crack injection, discussed in
Sec. 4.3.4. The top two graphs are for a maximum change in service temperature of AT = 20 °C,
while the bottom pair of graphs have a maximum change in service temperature of AT = 80 °C.
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From left to right, some of the properties of the substrate change. Both the tensile strength and
tensile elastic modulus decrease from left to right (Ebr and Rbr on the figure, see Table 1). Notice
the change from compatibility to incompatibility, going from top to bottom, as a function of AT.
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6. SUMMARY AND CONCLUSIONS

The main conclusions from this project are:

e the PC — CC compatibility space exists conceptually,

e the PC — CC compatibility space is possible to obtain for real materials, ,

o the Compatibility program had been validated and can be used to evaluate the compatibility of
repair materials with portland cement concrete substrates.

The following additional conclusions can be formulated on the basis of the results obtained
from computer simulation of the compatibility space for polymer composites and portland cement
concrete: (1) technical properties of polymer composites do exist that make the determination of
the compatibility space for a given polymer composite and portland cement concrete possible, (2)
obtaining polymer composites that fulfill the requirements of compatibility with portland cement
concrete is difficult but possible in practice, (3) the compatibility space for a given PC-CC system
should be treated as a necessary condition rather than a sufficient one, and (4) the analytical
selection of polymer composites for repair and/or anti-corrosion protection can be practically used as
an introductory evaluation of polymer composite usability in the given application.

59



7. REFERENCES

[1] L. Czamecki: The status of polymer concrete. Concrete International Design and
Construction, 7, 1985, 47-53

[2] D. Van Gemert, L. Czarnecki, R. Bares: Basis for selection of PC and PCC for concrete repair.
International Journal of Cement Composites and Lightweight Concrete, 10, 1988, 121-123

[3] CEN - European Committee for Standardization: Ratified text of the European Prestandard
ENV 1504-9:1997: Products and systems for the protection and repair of concrete
structures - definitions, requirements, quality control and evaluation of conformity — part 9:
General principles for the use of products and systems

[4] German Committee on Reinforced Concrete: Guidelines for the Protection and repair of
Concrete Components, 1992

[5] J. Wood, E. King, D. Leck: Concrete repair materials for effective structural application.
Construction and Building Materials 4, 1990, 64-67

[6] Federal Ministry for Transport: Additional Technical Contract Conditions and Guidelines
for the Protection and Repair of Concrete Construction Components ZTV-SIB 90, 1991

[7] L. Czamecki, J. Clifton: Polymer concrete; material design and optimization problems.
International Symposium on Concrete Polymer Composites, Bochum 1991, 63-71

[8] L. Czamecki, J. Clifton, Technical Evaluation System (TES) of Concrete-Polymer Composites
(TES-C-PC), RILEM Technical Committee 113 International Symposium, Ostende, 1995,
107-113

[9] J. Clifton, B. Oltikar: Expert System for selecting concrete constituents. ACI Publication on
State-of-the-Art computer applications, 1986, 1-24

[10] L. Czamecki, A. Garbacz, P. Lukowski, and J.R. Clifton, Optimization of polymer concrete
composites: Final Report, NIST Internal Report 6361, Gaithersburg, Maryland, USA
(1999).

[11] User’s Guide to Optimization Program, Warsaw University of Technology (1999)..

[12] RILEM TC 124-SRC Draft Recommendation: Repair Strategies for Concrete Structures
Damaged by Steel Corrosion. Materials and Structures 27, 1994, 415-436

[13] P. Emmons, A. Vaysburd: Factors affecting the durability of concrete repair: the
contractor’s viewpoint. Construction and Building Materials 1, 1994, 5-16

[14] L. Czamecki, J. Clifton: Polymer concrete for repairing. Material optimization and
compatibility problems, 3rd Southern African Conference On Polymers in Concrete,
Johannesburg 1997, 55-65

[15] P. Emmons, A. Vaysburd, J. McDonald: A Rational Approach to Durable Concrete
Repairs. Concrete International 9, 1993, 40-45

[16] D. O'Coonor, M. Saiidi: Compatibility of polyester-styrene polymer concrete overlays with
portland cement concrete bridge decks, ACI Materials Journal 90, 1993, 59-68

[17] Federal Ministry for Transport: Technical Guidelines for Crack Filling in the Concrete,
1993

[18] L. Czarnecki, P. ukowski, R. Nejman: The Statistical Evaluation of Epoxy Concrete
Heterogeneity. Cement and Concrete Composites 6, 1996, 417-428

[19] L.Czarnecki, A.Garbacz: Evaluation of polymer coating - crack-bridging ability.
International Colloquium ,,Industrial Floors ‘95”, Esslingen 1995, 703-705

[20] D. Plum: The behavior of polymer materials in concrete repair and factor influencing
selection. The structural Engineer 68, 1990, 337-346

60



[21] D. Plum: Materials - how to select. Construction Maintenance & Repair 11-12, 1991, 27-30

[22] D. Plum: Materials - what to specify. Construction Maintenance & Repair 7-8, 1991, 3-7

[23] D.Plum: Materials - why they fail. Construction Maintenance & Repair 9-10, 1991, 3-6

[24] L. Czarnecki, W. G odkowska, A. Wi ckowska: Model of compatibility of polymer
composite-cement concrete (PC-CC) system, Int.Colloquium “Durability of polymer based
composite systems for structural application", Brussels 1991, 484-493

[25] P. Emmons, J. McDonald, and A.Vaysburd, “Some compatibility problems in repair of
concrete structures — a fresh look,” in the proceedings of the International Colloquium
Material Science and Restoration, Esslingen 1992, 836-848

61



10.

11.

12.

APPENDIX 1: List of publications involved with the project

Czamecki L., Clifton J., Glodkowska W.: Problem of compatibility of polymer mortars and
cement concrete system. International Colloquium "Material Science and Restoration",
Esslingen, Germany (1992) 964-971

Czamecki L., Glodkowska W.: Polymer mortar - cement concrete system; problem of
compatibility, Proc. of the VII International Congress on Polymers in Concrete — ICPIC’92,
Moscow, Russia (1992) 420-429

Czarnecki L., Clifton J.: Technical Evaluation System (TES) of Concrete-Polymer Composites,
Proc. of the Inter. Symposium of the RILEM Technical Committee 113, Ostenda, Belgium
(1995) 107-113

Czamnecki L., Glodkowska W.: Approach to the compatibility of polymer composite cement
concrete (PC-CC) system., in Proc. of the International Conference "Progress in Durability
Analysis of Composite Systems, Brussels (1996) 317-323

Borjaniec W., Glodkowska W.: Criteria for polymer coating selection at reinforced concrete
tanks, Proc. 10™ International Conference "Reinforced and post-tensioned concrete silos and
tanks, Krakéw, Poland, (1995) 309-316

Czamecki L., Glodkowska W.: Model of compatibility between polymer composites and cement
concrete, Proc. X Conference-Kontra'96: Durability and anticorrosion protection of building
structures, Zakopane, Poland (1996) 69-74

Czarnecki L., Glodkowska W.: Polymers concrete as repair means -compatibility problem, Proc.
Int. ICPIC Workshop on "Polymer Concrete for Central Europe, Bled, Slovenja, (1996) 22-23
Czarnecki L., Lukowski P.: Material compliance of epoxy concrete, Proc. XLI Conference
KILiW PAN i PZITB, Krynica, Poland, (1996) 13-20

Czamecki L.: Materials for repair and restoration of reinforced concrete structures, Proc. of
Symposium: Repairing of high reinforced concrete constructions, Mildzyzdroje, Poland (1996)
9-23

Czamecki L., Jamrozy Z.: Repair materials for reinforced concrete structures, Building
Materials, 8 (1996) 2-6

Glodkowska W., Romanowski A.: Repair and anticorrosion protection of reinforced concrete
chimney, in Proc. of X Conference-Kontra '96: Durability and anticorrosion protection of
building structures, Zakopane, Poland , (1996) 121-126

Czarnecki L., Clifton J.: Polymer concrete for repairing. Material Optimization and
compatibility problem, Proc. of 3 ICPIC Southern African International Conference and
Workshop on Polymer in Concrete, Johannesburg, South Africa (1997)

62



13.

14.

15.

16.

17.

Glodkowska W., Piatek Z.: Experimental verification of compatibility between injection
material and concrete, Proc. 2™ Conference “Material problems in Civil Engineering-
MATBUD 98, Krakéw, Poland, (1998) 133-140

Czamecki L.: Materials for repair and anticorrosion protection of concrete structures,
Building Materials, 11 (1998) 8-14

L.Czarnecki: Materials for repair and strengthening of concrete structures, Proc. of the XIII
Conference Workshop for concrete structure designer, Ustron, Poland (1998) 21-38
L.Czamecki, A.Wysokowski: Materials for service, repair and strengthening of concrete bridge
structures, Proc. of the VIII Conference Contemporary Methods of Bridges Strengthening and
Reconstruction, Poznan, Poland (1998), 24-44

Czarnecki L., Glodkowska W., Piatek Z.: An assessment of usability of injection materials for

crack repairs in concrete structures, 2™ International Symposium on Adhesion berween

Polymers and Concrete-ISAP’99, Dresden (1999)

63






3

VERSION 1

& M
e,

L

Appendix 2: User’s Guide

USER'S MANUAL

EaRENRES ERRRANE
imNsnT AR RSN B a B R
,.-nl&--n--u.

FRREYERuRT PR

bolch . ,
AL RS
,-ﬁ?éw..-,m-. CARRIAAN
FEF s aum hw wmis wn ke i
FBjaNER punws RugR 0
wilntuinnn
w ERENEEY o n i ey o

-PL JOINT FUND 11

Prof. Lech Czarnecki , Ph.D., D.Sc.

"Polymer Composites for Repairing
gator
65

i

]l Invest

A L L

3
Hotly
* N

E S,
BT uwie

BUkEELLunRL DRR
B,

incipa

Pr

MARIA SKLODOWSKA-CURIE US

of Portland Cement Concrete: Compatibility Project"

Project MEN/NIST-95-234




Warsaw University of Technology, Poland

TABLE OF CONTENTS:

ACKNOWLEDGEMENT
SYMBOLS AND ABBREVIATIONS

1. INTRODUCTION

1.1. About software package COMPATIBILITY
1.2. Hardware requirements

2. GETTING STARTED

2.1. Program installation
2.2. Running program
2.3. Exiting program

3. PROGRAM UNITS
4, PROGRAM CONFIGURATION

4.1. Defining polymer composite properties
4.1.1. Editing parameters
4.1.2. Removing parameters
4.1.3. Adding new parameters

4.2. Defining concrete parameters

4.3. Defining functions

4.4. Defining models

4.5. Saving and loading parameters

5. CALCULATION
6. PRESENTATION OF RESULTS

7. HOW TO CONTACT THE AUTHORS

66



ACKNOWLEDGEMENT

The COMPATIBILITY package, version 1.3, was developed at Warsaw University of
Technology, Poland by Andrzej Garbacz, Wojciech Spychalski and Pawel Lukowski

under the scientific leadership of Prof. Lech Czarnecki (Warsaw University of

Technology) and | Dr James Clifton | (National Institute of Standards and Technology,

Gaithersburg, MD. In the preliminary stage of the work (DOS version) Andrzej Lenarcik
(Kielce Technical University) and Wieslawa Glodkowska (Koszalin Technical University)
were also involved. This development was funded by the Maria Sklodowska-Curie US-
Polish Joint Fund Il: Project MEN/NIST-95-234 "Polymer Composites for Repairing of

Portland Cement Concrete: Compatibility Project".

DISCLAIMER: This User's Guide is included as an Appendix to the Final Report of the
project “Polymer Composites for Repairing of Portland Cement Concrete: Compatibility
Project.” This has been done as a convenience for the reader, as the report often refers
to the Compatibility program. The User's Guide and Compatibility Program were written
solely by the Warsaw University of Technology. The National Institute of Standards and
Technology therefore does not endorse or stand behind this program, and does not

guarantee or warrant its results in any way.

DISCLAIMER: Certain commercial equipment is identified in this appendix in order to
adequately specify the experimental procedure. In no case does such identification
imply recommendation or endorsement by the National Institute of Standards and

Technology, nor does it imply that the equipment used is necessarily the best available

for the purpose.

67



SYMBOLS AND ABBREVIATIONS

SYMBOL UNITS
No. | SYMBOL | INPROGRAM TR&Q;{{%?}% PROPERTIES
PROPERTIES OF COMPOSITE (repair material)

1. h, hp [mm] Thickness of composite layer

2. R Rtpb [MPa] Adhesion of composite to the substrate; in
shear

3. Rp,”/" Rtr [MPa] Adhesion of composite to the substrate;
pull-off strength

4. R, Rpr [MPa] Tensile strength

3. E, Epr [MPa] Modulus of elasticity (in tension)

6. o epsP [mm/mm] Ultimate tension strain

7. s epsPS [mm/mm] Curing shrinkage

8. » Atp [1/K] Coefficient of thermal deformation

9. b Lp [W/m K] Coefficient of thermal conductivity

10. R np [-1 Poisson coefficient

11. D D [cm?2/s) Diffusion coefficient

12. t t [days] Time of concrete effective protection by
the coating

PROPERTIES OF CONCRETE SUBSTRATE

13. T dT K] Temperature gradient

14. I If [mm] Distance between cracks

15. R, Rbr [MPa] Tensile strength

16 E, Ebr [MPa] Modulus of elasticity (in tension)

17. » Atb [1/K] Coefficient of thermal deformationr -

18. b Lb [W/mK] Coefficient of thermal conductivity

19. a, dar [mm)] Crack width change

20. a, ar [mm] Maximum of crack width

21. l Iu [mm)] Bond length
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1 INTRODUCTION

Welcome to the COMPATIBILITY COMPUTER SYSTEM — CCS (version 1.3). This system is
designed for engineers and scientists interested in material selection for repairing and
anticorrosion protection of concrete structures.

1.1  About software package COMPATIBILITY
The software package COMPATIBILITY consists of three parts:

. diskette with the "packed" COMPATIBILITY program, formatted for a standard 3.5" disk,
1.44 MB floppy disk drive,

. registration card and program user licence,

. full documentation.

Before installation please carefully read the licence agreement and user's manual, and make a copy
of the distribution disk. Use the original disk only for installation (see section 2.2).

1.2. Hardware requirements

The program was written using the C++ programming language for the Windows 95/98 and NT 4.0
operating systems, and has the following basic hardware requirements: ‘

. IBM PC (or compatible) with Intel Pentium type CPU (a Pentlum IT CPU with operating at a
minimum of 200MHz is recommended),

. 16 MB of RAM memory,

. 5 MB free space on your hard disk,

. monitor and graphics card that ensure a resolution 1024x768 points (color); at lower
resolution the main windows are only partially displayed,

. laser or DeskJet printer connected to the LPT1 port.

2. GETTING STARTED

This chapter gives the details of how to install the program on your hard disk, how to run the
program, and how to exit the program.

2.1. Program installation

To start work with the COMPATIBILITY COMPUTER SYSTEM, it first should be installed on
the hard disk of your computer. There is a special installation program in the COMPATIBILITY
package. For installation, a 3.5" disk should be chosen.

To have a successful installation you should do the following operations:

1)  check your computer to determine if it has the minimum requirements listed above,
2)  prepare floppy diskette with program and registration card,
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3)  putone ofthe 3.5" disks into the floppy disk drive (usually A),
4)  choose the Run command from the Start menu and select drive A: |
5)  find setup.EXE and click [OK] .

This will start installation of the COMPATIBILITY COMPUTER SYSTEM on the hard disk of
your computer in default folder C:\ProgramFiles\Compatibility. Installation will be performed
according to standard Windows procedures. Deinstallation of the COMPATIBILITY package can
be performed according to standard Windows Procedure as well.

2.2. Running program

To run the COMPATIBILITY COMPUTER SYSTEM package choose the Programs command
from Start menu and next COMPATIBILITY. The information window (Fig.1) is displayed on
the screen after the program is running. The main menu window (Fig.2) of the COMPATIBILITY

Fig.1. Information window of the COMPATIBILITY program
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Fig.2. Main menu window after starting program

program appears after pressing the OK button. It consists of the typical elements for Windows
applications: title bar, menu, toolbar, working area, and status bar.

2.3. Exiting program

Correctly exiting The COMPATIBILITY program is very important. Don't turn off the computer
when the program is still running!. Turning off or restarting the computer with a working
program can damage the databases. Correctly exit from the program by choosing the Exit command

from the File menu or by pressing the proper button from the toolbar. This will end the program and
return to the operating system. This exit procedure assures the safety of your data.

3. PROGRAM UNITS

The COMPATIBILITY COMPUTER SYSTEM package is divided into four main units (see top
of Fig.2): File, Calculations, Options, About :
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* The File unit contains the commands involved with printing, copying and saving results of the
program (Fig.3)

Fig.3. File unit

e Using the Calculations unit the compatibility model can be chosen and calculation started

(Fig.4)

i Compatibility

Fig.4. Calculations unit

e The Options unit contains subunits for definition of composite and concrete properties,
inequalities and compatibility models (Fig.5). The settings can be saved in the default or a
selected folder. The settings can also be loaded from the selected folder

Fig. 5. Options unit
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e The About unit contains basic information about the program (Fig.6, see also Fig.1)

- Compatibility

The majority of commands are accessible from the toolbar to make work with the

Fig.6. About unit

COMPATIBILITY program easier (Table 1)

Table 1. Commands in program menu

Menu command

Description

File->Print

Printing of compatibility space

File->Print setup

Selection and configuration of printer

File->Save as...

Copy of compatibility space diagram to graphic file

File->Copy Copy of compatibility space diagram to clipboard
File->Exit Exit program
Calculations->Run Calculation starting

Calculations->Select model

Selection and edition of compatibility model

Options->Composite properties

Definition of composite properties

Options->Concerte properties

Definition of concrete substrate properties

Options->Equations

Definition of inequalities

Options->Models

Definition of compatibility model

Options->Save None Saving of setting files to default directory
Options->Save to... None Saving of settings files to selected directory
Options->Load from... None | Load of settings from selected directory
About->About None |Information about program

Switching among units of the COMPATIBILITY program can be made at any time from the Main
Menu. The program structure permits procedures to be successively performed: from data input,

through compatibility space calculation, to graphical presentation of the results.
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4. PROGRAM CONFIGURATION

Information on the configuration of the COMPATIBILITY COMPUTER SYSTEM is saved in
four text files with the dat extension: composite.dat, concrete.dat, equations.dat and models.dat.
In these files are stored information about the properties of the polymer composite and the
portland cement concrete substrates, compatibility conditions, and chosen models. At the start of
the program, this information is loaded from the default folder.

4.1. Definition of polymer composite properties

For definition of the composite properties, the Options menu should be used and then the
Composite command should be chosen. The suitable button on the toolbar can also be used. A
window (Fig.7) appears on the screen. The window consists of the table, in which the composite
parameters are defined, and of four buttons: OK, Cancel, New and Delete. Immediately after the
program is running, the table contains the preliminary defined parameters. The parameters can be
modified or removed, and the new ones can be created. The definition of the composites covers:
symbol

property

unit _

min (minimum value of the variability range of the parameter)

max (maximum value of the variability range of the parameter)

value (value of the parameter)

Fig.7. Configuration of the polymer composite parameters
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4.1.1. Editing parameters

The position of the cursor in the table can be selected by clicking, and then the second click
switches on the editing mode. The position can also be selected by using the arrow keys. Then by
pressing Enter the editing mode is switched on.

4.1.2. Removing parameters

Any parameter can be removed by selecting its value and then pressing the Delete button or key.
4.1.3. Adding parameters

Adding new parameters can be done by selecting the New button. A new row with empty

positions appears at the end of the table. Definition of the particular values is then performed in
the same way as in editing mode.

4.2. Defining of the concrete parameters

For defining the concrete parameters the Options -> Concrete command is used. After this
command is selected or the suitable button on the toolbar is pressed, the window shown in Fig.8
appears. This window is used similarly to the composite parameters window.

Concrete properties

Fig.8. Concrete parameters configuration
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4.3. Definition of functions

The functions can be defined by choosing the Options->Equations command or the suitable
button on the toolbar. The window shown in Fig.9 appears. The window consists of the list of
available functions and of five buttons: OK, Cancel, Edit, New and Delete.

ensPif>=dar
Lb/Lp<[E brAtb[Epr+Ebr)/{[Atp-Atb)E prE bi]
Rpiry=Rtpb
Rprhp/RbrepsP{1+epsPl>=ar+dar
Rprhp/RbrrepsP{1 +epsP]> =dar
4 Rpr>=0.3*Ep*epsPS5/(1-np)
d Rpr>=0.3*E preepsPS/{1-np)
Rpr>=Rtpb
Rpr>=Rtr
8 Rtpb>={epsP-Rbr/EbryE pr*Ebr/(E pr+Ebr]
58 Ripb>=0.3*Ep*epsPS/{1-np)
i Rtpb>=0.3Epr*epsPS/(1-np)
Rtpb>=Rbr
8 Rtpb> dT*{Atp-AtbJEprEbr/[Epr+Ebr)
Rtpp>=0.3"Ep epsPSA(1-np)
8 Rtpp>=0.3E prepsPS /{1-np)
&1 Rtpp>=Rbr
1 B> (Atp-AtbFEprEbrdt/E pr+Ebi)
B> =(e br/EbtFEnrE br/(Epr+Ebi)

Fig.9. Definition of the functions

For defining a new function, the New button should be chosen, and then the function can be input
in the special window (Fig.10). The functions can be linear, as well as square root - sqrt (X),
exponential — exp(X), or logarithmic — In(X), where X is the argument of the function. It is also
possible to nest the functions, meaning that the argument X can be given in function form. The
parameters used in the function definition should be in the same form as those used for the
definition of the composite and concrete parameters (first column in Fig.7 and Fig.8). The
inequalities definition is case sensitive.

Fig.10. New equation editing
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Editing an existing function is possible by its selection from the list and using the Edit button or
by double-clicking on the selected function. A dialogue window with the selected function
appears (Fig.11).

Fig.11. Equation editing
The function can be removed by its selection from the list and using the Delete button.
4.4. Defining models

Models can be defined by using the Options->Models command. The models definition window
(Fig.12) consists of two lists and five buttons: OK, Cancel, Edit, New and Delete. The left
window contains the names of the defined models. The contents of the right window depends on
the model chosen (in the left window) and contains the functions attributed to that model. By
using the New, Edit and Delete command, new models can be created and the existing ones can
be edited or removed.

INJECTION
4 REPROFILATION - NON-CRACKED SUBSTRATE
HIREPROFILATION - CRACKED SUBSTRATE
{COATING -CRACKED SUBSTRATE

COATING - NON-CRACKED SUBSTRATE

Fig.12. Defining models
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Existing and new models can be edited using a separate window (Fig.13). The window consists of
the model name, editing position, and two lists. The right list contains the functions attributed to
the selected model. In the left window the other available defined functions are listed. The
functions can be moved from one window to another by using the buttons placed between the
windows.

psPif>=dar Rtpb>dT*{Atp-Atb)EprEbr/[Epr+Ebr)
b/Lp<{Ebr*Atb}*(E pr+E br)/({Atp-Atb)E prEbr) Rpr>=0.3Ep*epsPS/(1-np)
pir>=Rtpb ™ Ripb>=0.3"Ep*epsPS/(1-np)
prrhp/RbrepsP*(1+epsP}> =ar+dar Ritpp>=0.3*Ep*epsPS /(1-np)
1 Rprhp/RbrepsP*(1+epsPp =dar Ripb>=(epsP-Rbr/Ebr)*E prEbi/{E pr+Ebr)
4 Rpr>=0.3*Epr-epsPS/(1-np) Rtr>=Rbr

tpb>=0.3*Epr*epsPS /{1 -np]
ERtpb>=Rbr
4 Rtpp>=0.3*EprepsPS/A1-np)
tpp>=Rbr
Rt [Atp-AtbPEprEbr*dt/(E pr+Ebi)
Rt> ={epsP-Rbr/Ebi)*E prEbr/(Epr+E br)
tr>=0.3*E priepsPS /(1-np)

Fig. 13. Model editing

4.5. Saving and loading parameters

The defined parameters can be saved in configuration files, loaded at the start of the program. For
this purpose the Options->Save command is used. The parameter configuration can also be saved
in a folder other than the default one by using the Options->Save to... command. After its
selection the dialogue window (Fig.14) appears, in which any folder can be selected.
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1= CA
1 (&= Program Files
(> Compatability

5 Dat

Fig.14. Selection of the folder for saving parameters

The saved configuration can be loaded by using the Options->Load from... command. After its
selection, the dialogue window (Fig.15) appears.

Program Files
(== Compatability
sy Dat

Fig.15. Selection of the folder for loading
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5. CALCULATION

For performing a calculation, one of the defined models should be chosen by using the
Calculations->Select model command. After its selection the dialogue window Select model
appears (Fig.16). At first, the pop-up list Model should be used for model selection. Then, the
parameters available for the selected model appear in the Concrete and Composite tables. The
values can be changed in the same way as defining the global parameters using the Options-
>Concrete properties and Options->Composite properties commands. Next, the axes and their
directions should be defined by using the lists and buttons from the Axis group. The composite
and concrete parameters as well as the axes of the COMPATIBILITY space can be defined
separately for four graphs. Any graph can be changed by using the buttons from the Window
selector group.

Fig.16. Selection of and editing the model

After all parameters are defined, the configuration should be confirmed by pressing OK. A
calculation is run by using the Calculations->Run command or the suitable button from the
toolbar. This command causes the calculation to be performed for all four graphs. The parameters
can also be defined and the calculation performed for a selected graph. This can be done by right-
clicking on the selected graph and selecting from the sub-menu (Fig.17) the Model command.
The dialogue window, similar to that used for the model selection, appears; but in this case there
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is no possibility for model changing. After confirmation by using the OK button, the selected
graph is re-calculated.

Fig.17. Sub-menu of the graph
6. PRESENTATION OF THE RESULTS

The calculation results can be copied to the clipboard (File->Copy), saved in the graphic file in
the form of the bitmap (File->Save as... (Fig.18)), or printed (File->Print). The commands from
the File group are applied to all four graphs (Fig.19). However, by using the graph sub-menu
(right-clicking on the graph, Fig.17), particular commands can be performed for the selected
graph. Using this graph sub-menu it is also possible to check (Fig.20), for a selected graph, which
requirement is not fulfilled in the case of non-compatibility being found (Check composite
command).

Fig.18. Saving of the figure to disk
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53 Compatibifily

Fig.19. Example of presentation of compatibility subspace for different coordinate systems
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Fig.20. Example of non-compatibility subspaces. In special window (right bottom) is shown
which inequality is unfulfilled
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7. HOW TO CONTACT THE AUTHORS

If, after reading this guide or using the COMPATIBILITY computer system, version 1.3, you have
any questions, comments, or suggestions, you should contact:

Prof. Lech Czarnecki

Institute of Technology and Organization of Building Production
Warsaw University of Technology

00-637 Warsaw, Al. Armii Ludowej 16, Poland

tel. (+4822) 825-76-37, fax.: (+4822) 825-74-15

e-mail: lcz@omk.il.pw.edu.pl
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